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chapter 1

Introduction
Thank you for purchasing the Drawmer 
Dynamics plug-in for Pro Tools®|HD and 
VENUE™ systems. 

Based in England, Drawmer has a longstanding 
reputation for creating high-quality, industry-
standard analog and digital signal processing de-
vices, including microphone preamplifiers, eso-
teric tube equipment, equalizers, and most sig-
nificantly, dynamics processors. 

The Drawmer Dynamics plug-in is a real-time 
TDM plug-in that retains the look and sound of 
tow of Drawmer’s renowned hardware units, the 
highly-acclaimed Drawmer DS201 and DL241.

There are two configurations of the Drawmer 
Dynamics plug-in:

DrawmerECL Providing an Expander, Compres-
sor, and Limiter.

DrawmerGCL Providing a Gate, Compressor, and 
Limiter.
Contents of the Boxed 
Version of Your Plug-In
Your Drawmer Dynamics plug-in package con-
tains the following components:

• Installation disc

• Activation Card with an Activation Code
Chapter 1: Introduction 1
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System Requirements and 
Compatibility
To use Drawmer Dynamics, you need the 
following:

• An iLok USB Smart Key

• An iLok.com account for managing iLok 
licenses

• One of the following:

• A qualified Pro Tools|HD system or 
Pro Tools|HD Accel system

– or –

• A qualified VENUE system

Avid can only assure compatibility and provide 
support for hardware and software it has tested 
and approved. 

For complete system requirements and a list of 
qualified computers, operating systems, hard 
drives, and third-party devices, visit: 

www.avid.com/compatibility

The Drawmer Dynamics plug-in does not 
support sample rates above 96 kHz.
Drawmer Dynamics Plug-Ins Guide
Registering Plug-Ins
Your plug-in purchase is automatically regis-
tered when you activate your iLok license (see 
“Authorizing Plug-Ins” on page 5).

Registered users are eligible to receive software 
update and upgrade notices. 

For information on technical support, visit 
www.avid.com.

Working with Plug-Ins
See the Pro Tools Reference Guide for general 
information on working with plug-ins in 
Pro Tools®, including:

• Inserting plug-ins on tracks

• Using clip indicators 

• Navigating the Plug-In window

• Adjusting plug-in controls

• Automating plug-ins

• Using plug-in presets



Conventions Used in This 
Guide
Pro Tools guides use the following conventions 
to indicate menu choices and key commands:
:

The names of Commands, Options, and Settings 
that appear on-screen are in a different font.

The following symbols are used to highlight 
important information:

Convention Action

File > Save Choose Save from the 
File menu

Control+N Hold down the Control key 
and press the N key

Control-click Hold down the Control key 
and click the mouse button

Right-click Click with the right 
mouse button

User Tips are helpful hints for getting the 
most from your Pro Tools system.

Important Notices include information that 
could affect your Pro Tools session data or 
the performance of your Pro Tools system.

Shortcuts show you useful keyboard or 
mouse shortcuts.

Cross References point to related sections in 
this guide and other Pro Tools and VENUE 
guides.
About www.avid.com
The Avid website (www.avid.com) is your best 
online source for information to help you get 
the most out of your Pro Tools system. The fol-
lowing are just a few of the services and features 
available. 

Product Registration Register your purchase 
online. 

Support and Downloads Contact Avid Customer 
Success (technical support); download software 
updates and the latest online manuals; browse 
the Compatibility documents for system re-
quirements; search the online Knowledge Base 
or join the worldwide Pro Tools community on 
the User Conference. 

Training and Education Study on your own using 
courses available online or find out how you can 
learn in a classroom setting at a certified 
Pro Tools training center. 

Products and Developers Learn about Avid 
products; download demo software or learn 
about our Development Partners and their 
plug-ins, applications, and hardware. 

News and Events Get the latest news from Avid 
or sign up for a Pro Tools demo.
Chapter 1: Introduction 3
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chapter 2

Installation and Authorization
Installing Plug-Ins for 
Pro Tools
Installers for your plug-ins can be downloaded 
from the Avid Store (http://shop.avid.com) or 
can be found on the plug-in installer disc (in-
cluded with boxed versions of plug-ins). 

An installer may also be available on the 
Pro Tools installer disc or on a software bundle 
installer disc.

To install a plug-in:

1  Do one of the following:

• Download the installer for your computer 
platform from www.avid.com. After down-
loading, make sure the installer is uncom-
pressed (.dmg on Mac or .ZIP on Windows).

– or –

• Insert the Installer disc into your computer. 

2  Double-click the plug-in installer application.

3  Follow the on-screen instructions to complete 
the installation.

4  When installation is complete, click Finish 
(Windows) or Quit (Mac).

When you launch Pro Tools, you are prompted 
to authorize your new plug-in.

For information on installing plug-ins for 
VENUE systems, see your D-Show guide.
Authorizing Plug-Ins
Software is authorized using the iLok USB Smart 
Key (iLok), manufactured by PACE Anti-Piracy.

An iLok can hold hundreds of licenses for all of 
your iLok-enabled software. Once a license for a 
given piece of software is placed on an iLok, you 
can use the iLok to authorize that software on 
any computer.

Authorizing Downloaded Software

If you downloaded software from the Avid Store 
(http://shop.avid.com), you authorize it by 
downloading a license from iLok.com to an 
iLok. 

iLok USB Smart Key

An iLok USB Smart Key is not supplied with 
plug-ins or software options. You can use the 
iLok included with certain Pro Tools systems 
(such as Pro Tools|HD-series systems), or 
purchase one separately.

For more information, visit the iLok website 
(www.iLok.com).
Chapter 2: Installation and Authorization 5
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Authorizing Boxed Versions of 
Software

If you purchased a boxed version of software, it 
comes with an Activation Code (on the included 
Activation Card).

To authorize software using an Activation Code:

1  If you do not have an iLok.com account, visit 
www.iLok.com and sign up for an account.

2  Transfer the license for your software to your 
iLok.com account by doing the following:

• Visit www.avid.com/activation.

– and –

• Input your Activation Code (listed on your 
Activation Card) and your iLok.com User 
ID. Your iLok.com User ID is the name you 
create for your iLok.com account.

3  Transfer the licenses from your iLok.com ac-
count to your iLok USB Smart Key by doing the 
following:

• Insert the iLok into an available USB port 
on your computer.

• Go to www.iLok.com and log in.

• Follow the on-screen instructions for trans-
ferring your licences to your iLok.

4  Launch Pro Tools.

5  If you have any unauthorized software 
installed, you are prompted to authorize it.
Follow the on-screen instructions to complete 
the authorization process.

For more information, visit the iLok website 
(www.iLok.com).
Drawmer Dynamics Plug-Ins Guide
Removing Plug-Ins
If you need to remove a plug-in from your 
Pro Tools system, follow the instructions below 
for your computer platform.

Mac OS X

To remove a plug-in:

1  Locate and open the Plug-Ins folder on your 
Startup drive (Library/Application Support
/Digidesign/Plug-Ins). 

2  Do one of the following:

• Drag the plug-in to the Trash and empty 
the Trash.

– or –

• Drag the plug-in to the Plug-Ins (Unused) 
folder.

Windows

To remove a plug-in:

1  Choose Start > Control Panel.

2  Under Programs, click Uninstall a program. 

3  Select the plug-in from the list of installed ap-
plications.

4  Click Uninstall.

5  Follow the on-screen instructions to remove 
the plug-in.



chapter 3

Drawmer Dynamics Parameters
This chapter explains the parameters of the 
Drawmer Dynamics Expander, Gate, and Com-
pressor modules.

For information on using Drawmer Dynamics, 
see “Using Drawmer Dynamics” on page 21.

DrawmerECL plug-in

DrawmerGCL plug-in
Adjusting Plug-In Parameters
You can adjust plug-in controls by dragging the 
control’s slider or knob, or by typing a value into 
the control’s text box. Additionally, some plug-
ins have switches that can be enabled by click-
ing on them.

To adjust a plug-in control:

1  Begin audio playback so that you can hear the 
control changes in real time.

2  Adjust the controls of the plug-in for the effect 
you want. Refer to “Editing Parameters Using a 
Mouse” on page 7 and “Editing Parameters Us-
ing a Computer Keyboard” on page 8.

Closing the plug-in will save the most recent 
changes.

Editing Parameters Using a Mouse

You can adjust rotary controls by dragging hori-
zontally or vertically. Parameter values increase 
as you drag upward or to the right, and decrease 
as you drag downward or to the left.
Chapter 3: Drawmer Dynamics Parameters 7
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Keyboard Shortcuts

 For finer adjustments, Control-drag (Win-
dows) or Command-drag (Mac) the control.

 To return a control to its default value, Alt-
click (Windows) or Option-click (Mac) the con-
trol. 

Increment & Decrement

For incremental parameter adjustment, click the 
up or down increment buttons at the right of 
each parameter text box.

Editing Parameters Using a Computer 
Keyboard

Some controls have text boxes that display the 
current value of the parameter. You can edit the 
numeric value of a parameter with your com-
puter keyboard.

If multiple plug-in windows are open, Tab and 
keyboard entry remain focused on the plug-in 
that is the target window.

To change control values with a computer 
keyboard:

1  Click the text box corresponding to the con-
trol that you want to adjust.

2  Change the value.

• To increase a value, press the Up Arrow on 
your keyboard. To decrease a value, press 
the Down Arrow on your keyboard.

– or –

• Type the desired value.

Using the increment and decrement buttons
Drawmer Dynamics Plug-Ins Guide
3  Do one of the following:

• Press Enter on the numeric keyboard to in-
put the value and remain in keyboard edit-
ing mode.

– or –

• Press Enter on the alpha keyboard (Win-
dows) or Return (Mac) to enter the value 
and leave keyboard editing mode.

Editing Parameters Using a Scroll 
Wheel

Some controls have text boxes that display the 
current value of the parameter. You can edit the 
numeric value of a parameter using a scroll 
wheel.

To change control values using a scroll wheel:

1  Click the text box corresponding to the con-
trol that you want to adjust.

2  To increase a value, scroll up with the scroll 
wheel. To decrease a value, scroll down with the 
scroll wheel.

Toggling Switches

To toggle a switch:

 Click the switch.

In fields that support values in kilohertz, 
typing “k” after a number value will multi-
ply the value by 1,000. For example, type 
“8k” to enter a value of 8,000.

To move forward through the different con-
trol fields, press the Tab key. To move back-
ward, press Shift+Tab.



Expander Module
The Expander is part of the DrawmerECL plug-
in and is modelled on the Drawmer DL241 and 
DS201 hardware processors.

For more information on using the Expander, 
see “Using the Expander Module” on page 24.

Features

 Auto-adaptive attack and release for a more 
musical response

 Upward expansion capability with a wide 
Threshold

 Adjustable Ratio with soft-knee options

 Gain reduction LED metering

A common problem with compression is that 
maximum gain compensation occurs during ex-
tremely quiet passages or during pauses. This re-
sults in an increase of background noise, the de-
gree of which depends on the amount of 
compression applied. 

The accepted way of dealing with this problem 
is to use an Expander for low-level gating that 
keeps quiet passages or pauses in the material 
clean. A problem with simple expanders is that 
they may undesirably process low-level audio 
signals, since the expander has no way of differ-
entiating low-level audio signals from noise. 

On a vocal track, for example, this can lead to 
the start or ending of words being accidentally 
removed, especially if the singer has a wide dy-
namic range.

Expander
Auto-Adaptive Expansion

The Expander has the ability to automatically 
adapt its settings to audio material. This mode of 
operation is enabled by turning the Ratio con-
trol fully clockwise to the Soft or Softer setting. 
It automatically varies ratio and release time de-
pending on the dynamics of the signal being 
processed.

The Expander’s transition from unity gain to 
maximum gain reduction is then dependant on 
how far the input level exceeds the threshold 
setting.

Because the onset of expansion is progressive, 
low-level signals will be processed with a lower 
ratio of expansion while the residual noise dur-
ing pauses will be processed with a higher ratio 
of expansion (resulting in greater attenuation). 
This makes the Expander easier to use effectively 
and more likely to preserve desired audio signals 
that are only slightly above the residual noise 
floor. 

Expander Parameters

Threshold Control

The Threshold control sets the level below 
which expansion starts to take place. Threshold 
range is from –70 dB to +12 dB.

Setting this control above 0 dB permits upwards 
expansion, where over-compressed material can 
be re-expanded. 
Chapter 3: Drawmer Dynamics Parameters 9
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Ratio Control

The Ratio control sets the amount of attenua-
tion applied to the signal as it decreases below 
the Threshold level.

Ratio range is from 1.1:1 to 50:1. At 1.1:1 the Ex-
pander closes only slightly (an input signal that 
is 10dB below the Threshold setting will be out-
put at –11 dB). At 50:1 the Expander functions 
like a Gate (an input signal that is 2 dB below 
the Threshold setting will be reduced by 
100 dB).

To enable the Expander’s ability to automati-
cally adapt its settings to audio material, turn 
the Ratio control fully clockwise until either the 
Soft or Softer setting appears.

Attack Control 

The Attack control sets the rate at which the Ex-
pander opens from a closed state. Attack speed 
ranges from 100 µS (0.0001 seconds) to 1.5 sec-
onds. A very fast attack time can sometimes pro-
duce audible clicks on low frequency signals.

Release Control

The Release control determines the speed at 
which the Expander closes to the Range setting 
once the input signal has fallen below the 
Threshold level. Release ranges from 50 ms to 
2.5 seconds.

With slow, legato audio material, very fast re-
lease times can result in audible and possibly 
undesirable side-effects, due to the gain chang-
ing too quickly.
Drawmer Dynamics Plug-Ins Guide
Range Control

The Range control sets the level to which the Ex-
pander will close, once the input signal has 
fallen below the Threshold setting. Range is 
from 0 dB (no expansion) to infinity (dB). In 
general, use a much smaller range setting than 
you would with a Gate.

Bypass Switch

The Bypass toggle switch bypasses the Expander.

Expander Gain Reduction (GR) Meter

This ten-element LED meter indicates from 0 dB 
to 90 dB of gain reduction. The number of illu-
minated LEDs will change as the Range control 
is adjusted, indicating the maximum gain re-
duction achievable. 



The Gate Module
The Gate is part of the DrawmerGCL plug-in. It 
is based on the highly acclaimed Drawmer 
DS201 hardware dynamics processor, which was 
instrumental in creating many recording effects 
that have become industry standard practice 
such as the Gated reverb, and enhanced percus-
sive kick-drums.

For more information on using the Gate mod-
ule, see “Using The Gate Module” on page 22.

Features

 Variable high-pass and low-pass filters for fre-
quency-conscious gating

 Comprehensive envelope control with attack, 
hold, release and range

 Ultra-fast response time

 Comprehensive side-chain filtering

 Key listen capability for monitoring the effect 
of the Key Filter

 LEDs for clear indication of Gate status

 Duck mode for voice-overs

Gate
Gate Parameters

HF & LF Key Filters

These controls adjust the roll-off frequencies of 
the Key filters. The LF or low frequency filter 
ranges from 32 Hz to 4 kHz and attenuates sig-
nals below the cut-off frequency at 12 dBs per 
octave. The HF or high frequency filter ranges 
from 250 Hz to 16 kHz and attenuates signals 
above the cut-off frequency. When both filters 
are used, only the frequency band between the 
two settings remains. 

These controls do not overlap each other, since 
this would produce very little audio output.

Side-Chain/Internal Control

Setting this control to Side-Chain enables side-
chain processing. Side-Chain processing permits 
triggering of the Gate by a mono source or key 
input other than the gated material itself. Setting 
this control to internal disables side-chain pro-
cessing. (See “Using the Key Side-Chain Circuit” 
on page 22 for more information.) 

Key Listen/Normal Switch

Set this toggle to Key Listen to monitor the au-
dio specified as the key input. (See “Using the 
Key Side-Chain Circuit” on page 22 for more in-
formation.)

Threshold Control

The Threshold control sets the level below 
which gating takes place (the level at which the 
output of the Key Filter triggers the Gate). 
Threshold ranges from –70 dB to 0 dB. Setting 
this control fully counter-clockwise closes the 
Gate.
Chapter 3: Drawmer Dynamics Parameters 11
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For most noise removal applications, set the 
Threshold as low as is possible, so that none of 
the desired signal is lost.

Attack Control

The Attack control sets the rate at which the 
Gate opens from a closed state. Attack ranges 
from 20 µS (about 1 sample) to 1.7 seconds.

A very fast attack time can sometimes produce 
audible clicks on low frequency signals.

Hold Control

The Hold control determines the amount of 
time the Gate is held open after the signal falls 
below the Threshold setting. Hold range is from 
2 ms to 2.2 seconds. Hold helps prevent spuri-
ous re-triggering of the Gate when using fast re-
lease times. It is also useful for creating the clas-
sic gated reverb sound often applied to drums.

The Hold cycle starts when the Threshold is 
crossed. Audio material with slow attacks re-
quires the Hold setting to be at least as long as 
the Attack setting for it to complete its attack cy-
cle.

Release Control

The Release control determines the speed at 
which the Gate closes to the Range setting after 
the input signal has fallen below the Threshold 
level. Release range is from 1 ms to 9 seconds. 
Longer releases help retain the original enve-
lopes of the gated audio.
Drawmer Dynamics Plug-Ins Guide
Range Control 

The Range control sets the level to which the 
Gate closes after the input signal has fallen be-
low the Threshold setting.

The range is from 0 dB (no gating) to infinity 
(fully gated, or no signal).

When Ducking is enabled, the Range control 
sets the level to which the signal will be reduced 
when open (triggered). For Ducking set this be-
tween –3 dB and –12 dB.

Gate/Duck Control

This toggle switch selects the Gate’s mode of op-
eration. In Gate mode, a signal above the 
Threshold will cause the Gate to open. In Duck 
mode, the audio passes unattenuated until the 
signal exceeds the Threshold. Ducking is mainly 
for applications such as voice-overs or removal 
of pops and clicks.

Bypass Control

The Bypass control bypasses the Gate.

Gate Envelope LED Meter

This traffic light-style LED shows the active state 
of the Gate envelope:

• When the Gate is closed, the red LED is lit. 

• When the Gate is open, only the green and 
yellow LEDs are lit. 

• When the input signal falls below the 
threshold, the yellow LED will light then 
fade over the duration of the release time.

In Duck mode, the green LED indicates an un-
triggered (resting) state.



Suggestions for Using the Gate

The fastest way to begin using the Expander is to 
choose one of the presets available in the Librar-
ian menu. (See the Pro Tools Reference Guide for 
details.) Alternatively, create your own settings 
using the procedure that follows.

To use the Gate:

1  Bypass the Compressor by clicking the Com-
pressor Bypass toggle.

2  Choose the key input mode (Side-Chain or In-
ternal). If you select Side-Chain, from the Side 
Chain Input pop-up, choose the input/bus that 
carries the audio you want to use to trigger gat-
ing.

3  To hear the key input audio source you have 
selected to control gating, click Key Listen.

4  To filter the key input so that only certain fre-
quencies trigger the plug-in, set the LF Key Filter 
and HF Key Filter controls to the desired fre-
quency range.

5  Begin playback. Gating is now controlled by 
the input/bus you chose as a key input.

6  Select the desired amount of reduction using 
the Range control. Typically, set this fully coun-
ter clockwise.

7  Set the Attack, Hold and Release controls. For 
material with long legato release, use a long Re-
lease time. For material with a lot of low fre-
quency content, use a slow Attack.

8  Adjust the Threshold control until the the ver-
tical VU meter and the LED meters, show gating 
activity. As a rule, the Threshold should be 
about 3 dB below the average input level to see 
and hear the dynamic processing.
Additional Tips for Effective 
Gating

Initially, set the LF Key Filter fully counter-clock-
wise and the HF Key Filter fully clockwise. This 
lets you hear the full audio spectrum of the key 
input. Set the Range control fully counter-clock-
wise and Key Listen to Normal.

With the Release control set at its midway posi-
tion, and with suitable program material fed 
into the Gate module, increase the Threshold 
level from its counter-clockwise position until 
the Gate starts to operate. This will be indicated 
by the LEDs. Pauses in the program should now 
be silent. If the Threshold setting is too high, the 
Gate will start to cut out desired audio. If so, ad-
just it as low as possible. 

If the ends of sounds are obviously being trun-
cated, a longer Release time may help. On the 
other hand, if unwanted noise is audible after 
the desired audio has ended, a shorter Release 
time is more appropriate.

Filtering Out Noise

There may be circumstances when the program 
material contains unwanted random noise or 
other sounds. For example, in a multi-miked 
drum kit set up, hi-hat will inevitably leak into 
the snare microphone, snare drum will leak into 
the kick drum microphone, and so on. 

Similarly, when processing audio recorded on 
location, you may experience problems due to 
wind or traffic noise or close-by conversation. If 
the unwanted noise is different in pitch to the 
desired audio, it is often possible, using Key Lis-
ten, to use the filters to tune in to the wanted 
sound while excluding as much of the un-
wanted sound as possible. Used carefully, these 
filters can significantly decrease false triggering 
of the Gate.
Chapter 3: Drawmer Dynamics Parameters 13
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Adjusting Attack Time Effectively

The Attack control has a very wide range. At its 
fastest, it can open instantaneously. Conversely, 
setting the Gate attack time too fast on material 
with a slow or moderate attack can cause clicks, 
particularly if the Threshold has to be set high 
because of excessive background noise. 

This is a common problem with noise gates, es-
pecially when processing low-frequency audio 
such as bass guitar or bass drum. With a high 
threshold, a low frequency sine wave will be ig-
nored as the signal starts from its zero level 
point.

As this wave climbs towards its peak, the level 
will suddenly exceed the threshold setting. At 
this point a very fast attack rate will switch the 
signal through the noise Gate with such a steep 
(almost vertical) leading edge that the low fre-
quency sound will have a single high frequency 
square wave added to its first cycle, causing a 
click. 

In cases like these, start with a fast attack time 
and moderate threshold, then gradually 
lengthen the attack time until the click disap-
pears when the Gate opens. 

Performing Ducking

Probably the most common form of Ducking is 
that used by radio announcers, whereby the vol-
ume of the background music being played is 
dropped, enabling them to speak over it. In 
Duck mode the Gate module can perform this 
effect. The music signal is routed to the input 
and the announcer's microphone signal is fed 
into the key input. (Be sure to set the key input 
to Side-Chain.)
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The Range control is used to set the level to 
which the music will drop when the Ducker is 
triggered from the key input. The envelope con-
trols determine the rate at which the level will 
drop and then recover. It is usual to select a me-
dium to fast Attack time, so that the music level 
drops rapidly as soon as the announcer begins to 
speak—with a slow Release time of a second or 
so. 

This will bring the music level back up slowly 
and smoothly. Some Hold time will help pre-
vent chattering, when the voice on the key in-
put pauses to breathe. This technique can also 
be used to reduce the level of other instruments 
during a solo.

Besides voice over applications, the Duck func-
tion of the Gate module can also be used to treat 
a signal where the peaks are too loud and require 
attenuating. In this application, Duck and Side-
Chain key input modes should be selected, and 
the Range control adjusted to give the desired 
attenuation to signals above the Threshold set-
ting. In extreme cases, the ducking action may 
be used to attenuate signal peaks, and by careful 
use of the filters, it may be possible to remove a 
snare drum from a drum mix or clicks and pops 
from a recording.

For most ducking applications, the lowest prac-
tical Threshold setting must be used.

Using a Stereo Gate

When using the Gate on a stereo signal, be 
aware that the control signal is derived by aver-
aging the left audio channel with the right au-
dio channel. Where one channel differs signifi-
cantly from another in a stereo track, better 
results may be obtained if the channels are 
treated as two mono channels. (For a side-chain 
key signal, the control is always a mono signal.)



By setting up a stereo plug-in with one channel 
in Gate mode and the other in Duck, the enve-
lope controls can be used to create interesting 
triggered panning effects, simply by feeding a 
mono signal into left and right channels and 
setting the Range control to maximum attenua-
tion.

Difficult Material To Gate

As with any Gate, noise can only be removed 
during pauses in the desired material. If noise 
contamination is serious enough to be evident 
even during moderately loud program material, 
simple gating will do little to help. In fact, the 
very fact that the Gate produces silence during 
pauses can make the noise content of the pro-
gram material even more apparent. In extreme 
cases, restricting the Range of the Gate to about 
–15 dB will adequately reduce noise during 
pauses but not sufficiently to cause an unaccept-
ably dramatic change in noise level as the Gate 
opens and closes.

Creative Use of the Key Input Filters

The key input filters in the Gate may also be 
used to good effect in situations where the de-
sired audio does not occupy the full audio spec-
trum. Conventional equalizers seldom have a 
sharp enough response to remove unwanted 
noise without also removing desired audio. 

Used with electric guitar, this produces little be-
low 100 Hz or above 3 kHz, so setting the Gate 
to Key Listen mode will enable you to use the fil-
ters to exclude much of the amplifier hum at the 
low end and hiss at the top end while having lit-
tle effect on the sound of the guitar. The same is 
true for acoustic guitar. The filters can be used to 
reduce fret noise or a player's breathing.
Other applications of the filters include remov-
ing unpleasant overtones from direct-injected 
instruments and warming up digital synthesizer 
sounds.

Tips For Using Key Inputs and Key 
Input Filtering

Complicated Keying

For a more intricate and musical key input, com-
bine several tracks together by bussing them to 
Auxiliary Inputs.

Leaving Key Listen Enabled

You can use the Gate as a simple filter by en-
abling Key Listen.

Key Filter Propagation Delay

Key input filtering with high frequency attenu-
ation can cause a slight delay in the time the 
Gate takes to trigger. Under most circumstances 
this will be imperceptible. However, when tran-
sient sounds are being processed with the HF 
Key Filter control set to a very low value, some 
degradation of the attack transient may become 
apparent.

Consequently, always set the HF Key Filter con-
trol to the highest possible value when process-
ing percussive sounds and set the Threshold as 
low as possible.

Cleaner Keying

It is often useful to use a Drawmer Dynamic 
plug-in to process the key input before it is used. 
Good results can be achieved by using an Ex-
pander (with the Compressor bypassed) on the 
key input source. This will give the key input 
source a more accentuated difference between 
Chapter 3: Drawmer Dynamics Parameters 15
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program and silence. With a cleaner key input, 
any associated gating will be more defined, and 
the Gate’s Threshold settings will be easier to op-
timize.

The Compressor Module
The Compressor, which appears in both the 
DrawmerECL and DrawmerGCL plug-ins, is 
based on Drawmer DL241 Compressor/Limiter 
harware unit.

Features

 Wide Threshold range for accurate compres-
sion

 Auto-adaptive Attack and Release for a more 
musical response

 Adjustable Ratio, ranging from very gentle 
compression to absolute Limiting

 Soft knee for progressive and unobtrusive 
compression

 Automatic Gain Make-up calculates the most 
suitable output Gain position for maximum 
data dynamic range

 Gain reduction meter

The Compressor combines aspects of both tradi-
tional ratio-style compressors and soft-knee 
compressors, making it equally adept at creative 
work and subtle level control. Traditionally, 
soft-knee compressors have been preferable for 
subtle level control where the original sound is 

Compressor
Drawmer Dynamics Plug-Ins Guide
changed as little as possible. Ratio-type com-
pressors are generally considered better suited to 
creative applications where large amounts of 
gain reduction are required. 

See “Using the Compressor Module” on page 24 
for more information on using the Compressor 
module.

Compressor Parameters

Threshold Control

The Threshold control determines the input 
level above which gain reduction will be ap-
plied. Threshold range is from –64 dB to +0 dB. 
Soft knee compression takes place for signals ex-
ceeding the threshold level by up to 10 dB. 
Above this level, conventional ratio compres-
sion is applied.

Ratio Control

The Ratio control sets the compression ratio ap-
plied after the 10 dB soft-knee region of the 
Threshold is exceeded.

Ratio ranges from 1.1:1 to infinity. This allows 
hard limiting with adjustable attack and release.

Attack Control

The Attack control sets the rate at which the 
Compressor will respond to input signals that 
exceed the Threshold level setting. Attack 
ranges from 100µS to 100 ms.

When Auto Attack and Release is enabled, the 
control knobs have no effect.



Auto (Attack & Release) Switch

This toggle switch disables the Attack and Re-
lease rotary controls and instead optimizes the 
Attack and Release times to suit the dynamics of 
the material being processed.

Enabling this setting will often produce the sub-
tlest level control on signals with widely varying 
dynamics or complete mixes.

Release Control

The Release control sets the rate at which gain 
returns to normal after the input signal level has 
fallen below the Threshold. Release range is 
from 50 ms to 5 seconds.

With very long release settings the Compressor 
may not have enough time to recover between 
the signal peaks. 

With very short release settings low frequency 
signals will have a tendency to distort as the 
Compressor tries to release on the signal sine 
wave. 

Gain Control

The Gain control has two functions, depending 
on the current state of the Auto Gain Make-up 
toggle switch. When Auto Gain Make-up is on, 
the control has a center-zero and is used as a fine 
trim for optimum output level. This should be 
centered at 0 dBfs, but can be reduced up to 
9 dB, or driven harder, in which case the signal 
will hit the Limiter.

When Auto Gain Make Up is turned on, the gain 
control becomes a ±9 dB trim. In manual mode, 
up to 36 dB of gain compensation can be added 
for level changes caused by Compression.
In the signal path, this control comes before the 
Peak Limiter detector. This fact should be taken 
into account when setting the Peak limiter 
threshold. Driving the gain too hard will often 
produce excessive limiting.

Auto Gain Make-Up Switch

With Auto Gain Make-Up on, Gain Make Up is 
adjusted automatically when the Compressor’s 
Threshold, Attack and Ratio or Limiter Thresh-
old are adjusted, so that the output level is as 
close as possible to the Limit Threshold. 

Compressor Gain Reduction Meter

This nine-element LED-style meter indicates 
from 0 dB to 30 dB of gain reduction.

Limit Threshold Control

The Limit Threshold control sets an absolute 
limit in decibels that the output signal is not al-
lowed to exceed. This control is normally left in 
its fully clockwise position, where preventative 
limiting will sometimes occur with audio mate-
rial containing high level peaks.

The Compressor Gain control should be used to 
ensure that the Peak Limiter operates rarely, if at 
all. Alternatively, you can deliberately drive it 
into limiting for creative effects.

Limit Gain Reduction Meter

This five-element LED-style meter indicates 
from 1 dB to 16 dB of gain reduction. The meter 
scale has been designed so that more sensitive 
amounts of limiting are displayed, rather than 
the maximum available.

When set to extremes, the Auto Gain Make-
up feature cannot restore enough gain to 
make back all the level that would be re-
quired to repair excessive Compression.
Chapter 3: Drawmer Dynamics Parameters 17
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Bypass (Compressor and Limiter) 
Switch

This toggle switch bypasses the Compressor and 
Peak Limiter. Normally it is used to compare the 
unprocessed signal with the processed signal.

Additional Suggestions for Using 
the Compressor

Setting up the Compressor is simpler if the Ex-
pander or Gate is initially set to Bypass and the 
Peak Limiter threshold set to maximum. This 
lets you adjust the Compressor in isolation.

Ratio Amount

The Ratio setting depends on how much the sig-
nal dynamics need controlling. As a rule, higher 
ratios provide a higher degree of control but also 
tend to be more audible in operation when high 
levels of gain reduction are required. The soft-
knee feature of the Compressor makes this far 
less pronounced. Overall, a higher ratio can be 
used than on conventional compressors with-
out compromising the sound quality.

Effective Gain Reduction

If the Attack & Release switch is set to Auto, set-
ting up is simply a matter of adjusting the 
Threshold control until the desired amount of 
gain reduction occurs. You can judge this partly 
by ear and partly by observing the gain reduc-
tion meter. 

A maximum gain reduction of between 8 dB 
and 12 dB is usually adequate. If more gain re-
duction is necessary, consider applying com-
pression during recording and then further 
compression while mixing.
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With Auto Gain Make-up disabled, rotate the 
Gain control until as near to 0 dB (full scale) sig-
nal output is seen at the VU meter. For greater 
simplicity, select Auto Gain Make-Up.

Background Noise

Compression during a mix increases the subjec-
tive level of background noises during pauses 
and quiet passages. Unless the noise problem is 
serious, the Expander can attenuate this noise to 
a very high degree, without compromising the 
desired audio signal.

Attack Times

The longer the attack time, the longer the Com-
pressor takes to respond to increases in signal 
level and a slow attack time is often used to ac-
centuate the beginning of percussive or plucked 
sounds such as drums, basses and guitars. a long 
attack time can also permit peaks to pass unat-
tenuated. The limiter will pick these up, so it is 
quite common with slow attack times to see in-
creased limiter activity. A fast attack time will 
bring the input signal under control very 
quickly.

Pumping

Pumping refers to heavy compression with incor-
rectly set envelope parameters. This results in 
very audible gain changes when the compressor 
attacks and releases. It is often an indication 
that the release time is too long. Release time 
should be set short enough so that the gain has 
returned to normal before the next signal peak 
occurs, and, in general, it should be set as short 
as possible before audible gain pumping occurs.

In most cases, an output of 0 dBfs is the opti-
mum output level. Lower output levels can be 
set using the Limiter Threshold. You might want 
to do this so that later inserts can better receive 



an optimized signal level at their input. If so, set 
the Peak Limiter Level to the desired output 
value then adjust the Compressor Auto or man-
ual Gain control to ensure minimum Limiter ac-
tivity.

Peak Limiter Bypass

The Peak Limiter has no bypass control. How-
ever, turning the Level control fully clockwise 
will prevent virtually all limiting. To use the 
Limiter while effectively bypassing the Com-
pressor, turn the Compressor Threshold fully 
counter clockwise to its maximum of +0 dB. 
Then set the Ratio to its lowest setting of 1.1:1 if 
Gain Make-Up is set to manual. Set the Gain to 
0 dB if Auto Gain is enabled.

Compensating for Apparent Dullness in 
Compressed Material

Compression can sometimes seem to have the 
effect of dulling audio material. Most of the en-
ergy in typical broadband music is contained 
within the bass range. This high energy causes 
the Compressor to operate, causing any quieter, 
high frequency sounds occurring at the same 
time to be reduced in level. That is why the cym-
bals and hi-hats in a heavily compressed drum 
track seem to dip in level whenever a loud bass 
drum or snare drum beat occurs.

The solution is to use less compression or in-
crease the attack time to allow the leading edge 
of the brighter sounds to pass through the Com-
pressor before gain reduction occurs. Though 
the semi-soft-knee compression systems used in 
Drawmer Dynamics modules tend to minimize 
this effect, in extreme cases, it may be necessary 
to add a little artificial brightness to the pro-
cessed sound using equalization or some form of 
exciter.
The Limiter
If the Compressor module is used with higher 
ratios, it will function as a Limiter. In addition 
to this feature, there is a separate auto-adaptive 
Peak Limiter. This not only catches any peaks 
that a slow Compressor attack might pass 
through unprocessed, but also lets the user set 
an absolute output signal level that will not be 
exceeded.

Limiting is extremely valuable in digital record-
ing where an absolute maximum recording level 
exists. When overdriven with Gain, it can also 
be used creatively to produce deliberate level-
pumping effects.

Meters and Indicators
Drawmer Dynamics provides several types of 
LED-type signal meters and indicators.

Peak Input LED

The Peak Input LED indicates peaks in input sig-
nals. At 1.0 dB below digital full scale the LED is 
amber. At –0.01 dB, (just below full scale input) 
it is red. If the Peak Input LED frequently flashes 
red, the input signal is clipping and should be 
reduced.

Peak Input LED
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VU Meter

The sixteen-element LED VU Meter shows out-
put levels after processing. Metering ranges from 
60 dB below full scale to 0 dBfs. Green LEDs in-
dicate levels below –4 dB. Yellow LEDs indicate 
levels from –3 dB to –1 dB. An amber LED indi-
cates –0.5 dB and turns red for peaks held at 
0 dBfs.

VU meter (stereo)
Drawmer Dynamics Plug-Ins Guide
Stereo Input Balance

This control, which appears only when Draw-
mer Dynamics is used in stereo, lets you correct 
an imbalance between stereo input images with-
out introducing any gain. (Stereo dynamic con-
trol is best achieved with a mix that is equally 
centered.) 

The LEDs show relative input balance and how 
far off center the incoming stereo mix is. A per-
fectly matching stereo input should produce vir-
tually no LED activity, regardless of audio level.

When centered, the Stereo Input Balance con-
trol has no effect. Moving the control to the left 
attenuates the right input signal by up to 6 dB 
and pans the image to the left. Moving the fader 
to the right attenuates the left input signal by up 
to 6 dB and pans the image to the right. 

Peak input LEDs appear at both ends of the me-
ter.

Stereo Input Balance control



chapter 4

Using Drawmer Dynamics
Drawmer Dynamics is a real-time TDM plug-in. 
It processes audio non-destructively in real time. 
It does not alter the original source audio, but 
only applies its effects during playback. 

Using Plug-Ins as Inserts
To use the Drawmer Dynamics plug-in, you 
must insert it in-line on an audio, Auxiliary In-
put, or a Master Fader track.

When more than one insert is used on a track, 
they process the audio in series, each effect be-
ing added to the previous one, from top to bot-
tom in the Mix window. 

Pre-Fader Operation

Drawmer Dynamics functions as a pre-fader in-
sert, meaning that its level is not affected by a 
track’s volume fader (except when used on a 
Master Fader). 

For this reason, clipping can occur if you boost 
its gain to extremes. This is particularly true on 
tracks recorded at high amplitude. Watch on-
screen metering to identify and rectify clipping 
if it occurs. 
Inserting Drawmer Dynamics 
on a Track
To use Drawmer Dynamics in a Pro Tools ses-
sion, add it to a track as an insert.

To show inserts in the Mix window:

 Choose View > Mix Window > Inserts.

To insert Drawmer Dynamics on a track:

 Click the Inserts selector on a track and select 
the plug-in that you want to use. 

To remove Drawmer Dynamics from a track:

 Click the Insert selector and choose No Insert.
Chapter 4: Using Drawmer Dynamics 21
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Using The Gate Module
The Gate is part of the DrawmerGCL plug-in. 

Using the Key Side-Chain Circuit 

The DrawmerGCL features internal and external 
Key side-chain capabilities. The side-chain cir-
cuit takes an internal or external Key input and 
uses that source to trigger affect the gate’s be-
havior. Use the internal low- and high-pass Key 
filters to take advantage of frequency-conscious 
gating.

You can use the external sidechain feature to 
trigger the gate from an external source such as 
another mic or instrument.

Using the Internal Key Filters

A common production technique is to use Key 
filter controls to filter out specific frequencies 
from triggering the gate’s threshold. 

For example, hi-hat bleed into a snare mic is a 
common problem. If you try to gate out the hi-
hats, you might have to set a threshold so high 
that some of the snare drum’s hits are inaudible.

You can use the DrawmerGCL to keep the hi-hat 
(which operates at a higher fundamental fre-
quency than a snare drum) from opening the 
gate, which allows you to set the gate’s thresh-
old lower and preserve all of the drum hits.
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To use the DrawmerGCL to gate out hi-hats from a 
snare track:

1  Insert the DrawmerGCL on the snare drum 
track.

2  Ensure the Key Input selector is set to No Key 
Input.

3  Set the Key section to the Internal setting.

4  Solo the snare drum.

5  Begin playback. 

6  Adjust the threshold of the gate so you can 
hear gating.

7  Click Key Listen to listen to how the filters are 
acting on the snare drum.

8  Adjust the HF Key Filter control to around 
1kHz, so that you hear mostly snare drum. You 
will hear the hi-hat slowly disappearing from 
the gated snare channel.

9  Click the Key Listen switch to normal.

10  Fine-tune the threshold, attack, and release 
so that all snare hits are preserved, but the hi-hat 
is effectively gated out of the snare mic.

Key filters section

HF Key 
Filter

LF Key 
Filter

Key Listen
switch

Internal



Using a Key Input for External Side-
Chain Processing

With external side-chain processing, a plug-in's 
detector is triggered by an external signal (such 
as a separate reference track or audio source) 
known as the key input.

An effective use of this feature is to use the snare 
drum as the trigger for opening gates inserted on 
room mics, giving the snare an extra added 
“pop.”

To use a snare to trigger gating on a room or 
ambient mic track:

1  Insert the DrawmerGCL on your room or am-
bient drum mic tracks.

2  On the snare track, click the send selector to 
choose any open bus send.

3  Set the snare’s output bus send that you se-
lected to “0.”

4  On the room or ambient mic track, click the 
Key Input selector and select the bus carrying 
the audio from the snare track.

Selecting a Key Input
5  Set the Key section to the Side-Chain setting.

6  Click Key Listen to hear the audio source (in 
this case, the snare drum) you have selected to 
control the side-chain input. 

7  Begin playback. Gating is now controlled by 
the snare, which you chose as the key input.

8  Adjust the Noise Gate’s Threshold to fine tune 
side-chain triggering.

9  Adjust other parameters to achieve the exact 
effect you want.

DrawmerGCL Key filter controls 

Sidechain switch

HF Key 
Filter

LF Key 
Filter

Key Listen
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Using the Expander Module
The Expander Module is part of the Draw-
merECL.

The fastest way to begin using the Expander is to 
choose one of the presets in the Librarian menu. 
(See the Pro Tools Reference Guide for details.) Al-
ternatively, create your own settings using the 
procedure that follows.

To use the Expander:

1  Bypass the Compressor by clicking the Com-
pressor Bypass toggle.

2  Select the desired amount of reduction using 
the Range control.

3  Set the Attack and Release controls based on 
the character of the audio material you want to 
expand. For material with long, legato release, 
set a long Release. For material with a lots of low 
frequency content, set a slow Attack. For sharp, 
percussive sounds, set a short Attack.

4  Set the Ratio control based on the character of 
the audio material. Try a maximum setting of 
2.5:1 for vocals, and higher ratios for dynamic, 
full mix material.

5  Adjust the Threshold control until the vertical 
VU meter and the Expander Gain Reduction 
(GR) meter begin to light.

As a rule, the Threshold should be between 6 dB 
to 10 dB below the average input level. Use a 
section of audio material with pauses and adjust 
the threshold to be as low a dB level as possible 
while still attenuating the noise during pauses. 
Listen carefully to how the sounds come in after 
the pauses and how cleanly they fade away 
again. If the Expander changes the sound in an 
unacceptable way, the Threshold is probably set 
too high. 
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Using the Compressor Module
The Compressor appears in both the Draw-
merECL and DrawmerGCL plug-ins.

The fastest way to begin using the Compressor is 
to choose one of the presets available in the Li-
brarian menu. (See the Pro Tools Reference Guide 
for details.)

Alternatively, create your own settings using the 
procedure that follows.

To use the Compressor:

1  Bypass the Gate or Expander by clicking their 
Bypass toggle.

2  Turn on Auto Attack & Release.

3  Turn on Auto Gain Make-up.

4  Set the Limiter control fully clockwise.

5  Set the Ratio control. For vocals, try 2.5:1 or 
less. For full mixes use even less. For dynamic 
single tracks, use more.

Adjust the Threshold control until the vertical 
VU meter and the Compressor Gain Reduction 
(GR) meter show activity. As a rule, the Thresh-
old should be 6 dB to 10 dB below the average 
input level to hear much change.



appendix a

DSP Requirements
The number of TDM plug-ins you can use at one 
time depends on how much DSP power is avail-
able in your system. Since the TDM hardware on 
Pro Tools cards provide dedicated DSP for plug-
ins, plug-in performance isn’t limited by CPU 
processing power.

The DSP tables in this appendix show the theo-
retical number of instances of each plug-in that 
can be powered by a single DSP chip on 
Pro Tools|HD cards. DSP usage differs according 
to card type. 

There are a total of nine DSP chips on a 
Pro Tools|HD card (HD Core, HD Process, and 
HD Accel). HD Core and HD Process cards pro-
vide identical chip sets. HD Accel cards provide 
newer, more powerful DSP chips (making the 
HD Accel card ideal for DSP-intensive plug-ins, 
and for high sample rate sessions). 

DSP tables show the theoretical maximum 
performance when no other plug-ins or sys-
tem tasks (such as I/O) are sharing avail-
able DSP resources. You will typically use 
more than one type of plug-in simultane-
ously. The data in these tables are provided 
as guidelines to help you gauge the relative 
efficiency of different plug-ins on your sys-
tem. They are not guaranteed performance 
counts that you should expect to see in typ-
ical real-world sessions and usage. 
Not all plug-ins are supported on all types of 
chips. The following tables indicate the number 
of compatible chips per card.

Using Multi-Mono Plug-Ins on 
Greater-Than-Stereo Tracks

Plug-Ins used in multi-mono format on greater-
than-stereo tracks require one mono instance 
per channel of the multi-channel audio format. 
For example, a multi-mono plug-in used on a 
5.1 format track, requires six mono instances 
since there are six audio channels in the 5.1 for-
mat.

Monitoring DSP Usage

The System Usage window (Window > System 
Usage) shows how much DSP is available in your 
system and how it is being used in the current 
Pro Tools session.

For more information about DSP usage and 
allocation, see the Pro Tools Reference 
Guide.
: 25
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Drawmer Dynamics DSP Requirements
The Drawmer plug-ins have the following DSP requirements:

HD Accel Card

Table 1. Maximum instances of plug-ins per DSP chip for a
Drawmer Dynamics Plug-Ins Guide
n HD Accel card, at different sample rates,
HD Core and HD Process Cards

(mono and stereo).

Sample Rate: 44.1/48 kHz 88.2/96 kHz
Compatible DSP Chips per HD Accel 

Card

Plug-In Mono Stereo Mono Stereo

DrawmerECL 8 4 4 2 9

DrawmerGCL 8 4 4 2 9
Table 2. Maximum instances of plug-ins per DSP chip for a
n HD Core or HD Process card, at different sample rates 

(mono and stereo).

Sample Rate: 44.1/48 kHz 88.2/96 kHz
Compatible DSP Chips per HD Core or 

HD Process Card

Plug-In Mono Stereo Mono Stereo

DrawmerECL 4 2 2 1 9

DrawmerGCL 4 2 2 1 9
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DSP Delays Incurred by TDM Plug-Ins
Virtually all TDM plug-ins incur some amount 
of signal delay.

If you are working with mono tracks, or are pro-
cessing all channels with the same plug-in, the 
signal delays are not long enough to be signifi-
cant and should not be a concern.

This signal delay is significant only if you use a 
plug-in on one channel of a stereo or multichan-
nel signal but not the others, since this can 
cause the channels to be slightly out of phase.

Pro Tools systems provide automatic Delay 
Compensation (and other methods) to com-
pensate for signal processing delays. For de-
tailed information, see the Pro Tools Refer-
ence Guide.
Table 3 shows the delays inherent in each Draw-
mer Dynamics plug-in.

Drawmer Dynamics DSP Delay


Table 3. Samples of delay incurred by each TDM plug-in 
on Pro Tools|HD cards

Plug-In
Samples of Delay on 
Pro Tools|HD Cards

DrawmerECL 7

DrawmerGCL 7
Appendix B: DSP Delays Incurred by TDM Plug-Ins 27
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appendix c

Drawmer Dynamics Demo Sessions
Several demo sessions are included with 
Drawmer Dynamics. These sessions illustrate 
how to use the plug-in during typical recording 
scenarios.

Using the Demo Sessions
Before opening a demo session, you must have 
already installed and authorized the Drawmer 
Dynamics plug-in.

To open a demo session:

1  Locate and open the demo sessions folder 
(Digidesign/Drawmer Dynamics/Drawmer Dy-
namics Demo/Demo Sessions).

2  Double-click the desired demo session.

3  When the session opens, press the Spacebar to 
begin playback. 

4  Click Bypass to compare the track with and 
without dynamics processing.
About the Demo Sessions

Following are brief descriptions of each demo 
session and the features they illustrate.

“Gated Tones” Demo

This session illustrates keying of two different 
tone bursts from an existing short drum loop us-
ing the Gate. The three-channel session uses two 
Gates. The key input is from the original drum 
track.

“Snare” Demo

This session illustrates a gated reverb effect us-
ing the Gate and a modified variation of 
“Gate&Comp Staccato” setting with a reduced 
Gate Threshold to compensate for low signal 
level. Notice how the reverberated sound is 
shortened. Imagine that the reverb could also be 
high level noise. Gate Release greatly affects the 
output.

The unprocessed audio in this session is 
very loud. Turn down your monitoring sys-
tem if you plan to bypass the Gate.
Appendix C: Drawmer Dynamics Demo Sessions 29
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“Noise Removal” Demo

This session illustrates how to use the Expander 
to effectively remove excessive background hiss 
from a short drum loop. Use the Bypass button 
to compare the processed and unprocessed au-
dio.

“Wrong & Right” Demo

This session illustrates the right and wrong way 
to use a Gate. The same bass guitar audio ap-
pears on two tracks. Both tracks have the same 
Gate assigned, but each has differing parameter 
settings. Notice that using the wrong Threshold, 
Attack, Hold and Release settings can give very 
poor results from low frequency signals. Use 
Solo and Mute to compare the effect of the right 
and wrong settings.

“VoxOver” Demo

This session illustrates how to use the Gate to 
perform ducking. Note how the levels of the 
music tracks are attenuated whenever the vocal 
track comes in. This technique is frequently 
used in radio, film, and commercial voice-overs, 
or anywhere that automatic control over back-
ground pad level is required.

Note that one audio source (the vocal track) is 
used to trigger two separate mono backing 
tracks by positioning the key selector switch 
centrally. In reality, the amount of ducking in 
this demo is excessive, and often as little as 3 dB 
of attenuation may be sufficient.

The main vocal track utilizes the Expander to re-
move headphone spill/background noise.

Try inverting the Gate/Duck switch of one of 
the Gates. This will result in distinct panning of 
the outputs during the duration of the vocal 
track.
Drawmer Dynamics Plug-Ins Guide
“Extra-Clean-Key & Drum” Demo

This session illustrates keying of a short drum 
loop from a composite track of mixed sine wave 
tones. The tone mix is first cleaned using the Ex-
pander assigned to the first mixer insert button. 
This audio is then used as a key input. The result 
is a cleaner key signal for the Gate. 

This demo includes automation that shows how 
you can vary the Threshold parameter to ignore 
a key input.

“Clean & Dirty Drums” Demo

This session illustrates three different styles of 
processing using both the Gate and the Ex-
pander. There are three audio tracks, each of 
which demonstrates a different effect:

 The left audio channel (“Rhythm <L”) carries 
the original “scratchy” audio. The DrawmerGCL 
plug-in is loaded in a bypassed state. Adjusting 
the Gate Threshold to about –20 dB will allow 
the rest of the drum track to pass through the 
plug-in.

 The right audio channel (“Rhythm >R”) car-
ries the audio after being bounced and pro-
cessed. This channel has a DrawmerECL plug-in 
that once enabled, demonstrates Upward Ex-
pansion. This shows how to add more life to a 
track that suffers from an over-squashed dy-
namic range.

 The center channel carries audio that has 
been over processed. This shows the kind of ef-
fect that can be achieved with this type of dou-
ble-pass processing.
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